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ModusToolbox™ tools package version 3.1.0

Device Configurator version 4.10

About this document

Scope and purpose

This guide provides information and instructions for using the Device Configurator to update various
parameters for you ModusToolbox™ application.

Intended audience

This document helps application developers understand how to use the Device Configurator as part of creating
a ModusToolbox™ application.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus
Italics Denotes file names and paths.

Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,

Courier New . . S .
directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Abbreviations and definitions

e Resource - Includes peripherals, pins, clocks, etc. used in an application.
e Configurator - A GUI-based tool used to configure a resource.

e Application - One or more projects related to each other.

e Personality - A file that defines a resource behavior.

e Device Support Library - A device support library provides critical firmware and device data files to
configurators. Device support libraries are identified with a file named props.json. It is used to find things
like other tools, devices, and personalities.

Reference documents
Refer to the following documents for more information as needed:

e ModusToolbox™ tools package user guide

e ModusToolbox™ tools package release notes

e APlreference guides
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Overview

1 Overview

The Device Configurator is part of a collection of tools included with the ModusToolbox™ software. Use the
Device Configurator to enable and configure device peripherals, such as clocks and pins, as well as standard
MCU peripherals that do not require their own tool.

Some complex peripherals, such as CAPSENSE™, SegLCD, etc., have specialized configuration tools, and the
Device Configurator provides links to launch those separate tools (see Launch other configurators). After
configuring and saving a particular device’s settings, the Device Configurator generates firmware for use in your
application (see Code generation).

ﬁ C:fUsers/follettcj/mtw3.1/3-8-23/Helle_World/bsps/TARGET_APP_CY8CKIT-06252-42012/config/design.modus - Device Configurator 410 - [m] x
File Edit Settings View Help
CYBC624ABZ1-52D44 LBEE39B1LV/CYW43012COWKWBG CSD (CapSense, etc)) 0 (CYBSP_CSD) - Parameters g X
Peripherals ~ Pins  Analog-Routing  System Peripheral-Clocks ~ DMA Enter filter text... ._L| g B
Enter filter text... Z|7 B & B || [Name Value A
Resource Narne(s) Personality v Ovenview
Analog ‘/,\‘ Configuration Help Open CSD Documentation
Communication ') CAPSENSE™ Middleware Open CAPSENSE™ Documentation
v Digital (3) CSDADC Middl Open CSDADC Documentation
] PDM-PCM Converter 0 audioss_0_pdm_0 2
@
Timer, Counter, and PWM (TCPWIA) 0 CSDIDAC Middleware Open CSDIDAC Documentaticn
Timer, Counter, and PWM (TCPWM) 1 ¥ Inputs
v System (Z) Clock & | @ 8 bit Divider 0 clk (CYBSP_CSD_CLK_DIV, CYBSP_CS_CLK_DIV) [USED] ~
CSD (CapSense, etc.) 0 CYBSP_CSD CSD-3.0 v CAPSENSE™
[ LCD Direct Drive 0 Icd_0_drive_0 (2) Enable CAPSENSE™

(2) Target CPU core Cortex M4 ~
v Extemal Tools

O Multi-Counter Watchdog Timer (MCWDT) 0 [s:
[ Multi-Counter Watchdog Timer (MCWDT) 1=
[ Real Time Clock (RTC)

(7) CAPSENSE™ Configurator | Launch CAPSENSE™ Configurator

() CAPSENSE™ Tuner Launch CAPSENSE™ Tuner
~ CSDADC
(%) Enable CSDADC O v

CSD (CapSense, etc.) 0 (CYBSP_CSD) - Parameters ~ Code Preview

Notice List g X
OO Errors I 0Warnings DOTasks 04 Infos
Fix Description Location
Ready
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Launch the Device Configurator

2 Launch the Device Configurator

You can launch the Device Configurator in various ways as described in this section; however, the tool's
configuration (design.modus) file requires an association to an application in order to obtain device
configuration information.

The design.modus file contains all the required hardware configuration information about the device for the
application. When you save updates, the Device Configurator generates/updates source code in the
GeneratedSource directory next to the design.modus file. Applications use the design.modus file and generated
source code in future application builds.

2.1 make command

As described in the ModusToolbox™ tools package user guide build system chapter, you can run numerous
make commands in the application directory, such as launching the Device Configurator. After you have created
a ModusToolbox™ application, navigate to the application directory and type the following command in the
appropriate bash terminal window:

make device-configurator

This opens the Device Configurator using the application's design.modus file.

2.2 VS Code and Eclipse

VS Code and Eclipse have tools to launch the BSP Assistant from within an open application. Refer to the
applicable user guide for more details:

e VS Code for ModusToolbox™ user guide

e Eclipse IDE for ModusToolbox™ user guide

2.3 Executable (GUI)

If you don't have an application or if you just want to see what the configurator looks like, you can launch the
Device Configurator GUI by running its executable as appropriate for your operating system (for example,
double-click it or select it using the Windows Start menu). By default, it is installed here:

<install_dir>/ModusToolbox/tools_<version>/device-configurator-<version>

When launched this way, the Device Configurator opens without any configuration information. You can either
open a specific *.modus file or create a new one.

User Guide 40f 27 002-24377 Rev. *I
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2.4 Open configuration file

Click File > Open and navigate to the location of the *.modus file to open. The tool may open the following
dialog, indicating that it cannot find the device support library (props.json) file:

Failed to open: C:/Users/follettc)/mtw3.0/6684/multi/Multi-Core-Prototype/bsps/
TARGET_APP_CYBCPROTO-062-4343W/COMPONENT_BSP_DESIGN_MODUS/design.modus

Provided libraries incomplete. No personality information found.

Libraries:
C:/Users/follettc)/miw3.0/6684/multi/mth_shared/mtb-pdl-cat1/release-v2.0.0/
devicesupport.xml

Use the following dialog to manually enter the device support libraries.

Pre-ModusToelbox 2.0 designs:
Enter a single path to a 'devicesupportxml' file found in the device support library folder.

Post-ModusToolbox 3.0 designs:

Two library paths are required. One to the 'props.json’ file found in the device support
library falder, and one to the ‘props,json’ file in the global ‘device-db’ folder (default
lecation: [USER'S HOME]/ modustoolbox/global/device-db).

By default you'llfind the device support library folder in the workspace's mth_shared
folder. The correct device support library depends on your selected target:

PSoC & leck in the mtb-pdI-cat1 folder.

P5SoC 4: look the mth-pdl-cat2 folder.

KM look in the mtb-xmclib-cat3 folder.

BTSDK v2.2 and later: lock in the appropriate chip-specific folder (default: mtb_shared/
wiced_btsdk/dev-kit/baselib/<chip>).

Note: Some applications may contain a private copy of the device support library in the
‘libs’ subfolder.

The dialog provides pointers for where you can find the appropriate file for your device. Click OK to close the
dialog, and then navigate to the appropriate directory containing the props.json file.

2.5 Create new configuration
Click File > New to open the Create Design dialog, which provides fields to create new *.modus files.
To create a new *.modus file:

1. Clickthe Browse [...] button next to File name, navigate to the location to save the new file, and enter a
file name.

2. Clickthe Browse [ ... ] button next to Libraries, navigate to the location of the device-db props.json file,
and select it. Also, find and select the appropriate PDL props.json file.

3. Select a Device from the pull-down menu.
4. |If applicable, select one or more Additional devices from the list.

5. Click OKto close the dialog and load the new *.modus file into the Device Configurator.

[ Create Design - Device Configurator 4.10 X
File name: ‘C:-Uiﬂ:-Pl,ll:l\-:-Exemp\E-T-—F‘.GETJ.-I;ESP-E-«l-ZJ--:DHf\g design.modus \
Libraries: ‘C:

ers/follettcj/mtw3.1/5-8-23/mtb_shared/mtb-pdi-cat]/release-v3.3.1/propsjson
C:/Users/follettcj/.modustoolbox/global/device-dby release-v4.4.0/props.json

Device: [ cYace144FMI-S4F T3 ]

Enter filter text...

CYW4343WKUBG [
[0 CYw4343wKwes

[ cyw43438KUBG

[ cvw43439KUBG

[ LBEESKL1DX v

Additional devices:

PSoC 4 Product Selector

PSoC 6 Product Selector

Documentation:  [xMC1000 Product Selector
MCA000 Product Selecter

Cancel
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2.6 Executable (CLI)

The Device Configurator executable can be run from the command line, and it also has a "cli" version of the
executable as well. Running configurator executables from the command line can be useful as part of batch
files or shell scripts to re-generate the source code based on the latest configuration settings. The exit code for
the executable is zero if the operation is successful, or non-zero if the operation encounters an error. For more
information about the command-line options, run the executable using the -h option.

002-24377 Rev. *I
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3 Quick start

This section provides a simple workflow for how to use the Device Configurator.

1. Launch the Device Configurator.

2. Enable a desired peripheral on the Peripherals tab by clicking the enable check box. Notice the Parameters

pane becomes populated with fields.

Ci/Usersfollettcy/ mtw3.1/5-8-23/Helle_World/bsps/TARGET_APP_CY8CKIT-06252-42012/ config/design.modus” - Device Configurater 4.10 - ul X
File Edit Settings View Help
CYACE24ABZI-52D44  LBEESOBILV/CYWA012COWKWEG 12-bit SAR ADC - Parameters 8 x
Peripherals  Pins  Analog-Routing  System  Peripheral-Clocks  DMA Enter filter text.. 1]
g g Sy p & B
[Enter fiter text.. Z|7 B K B || [Name Value "
Resource Name(s) Personality A | |V Overview
~ Anslag (%) Configuration Help Open SAR Documentation
[ Low-Power Comparator 0 ~ GE"‘E_’E‘
[ Low-Power Comparstor 1 () Vref Select Internal Reference (from AREF Resource) ~
v Programmable Analog 0 (2) ref Voltage (V) 5 0.000
12-bit SAR ADC () Number of Channels [2 |
[ AREF (%) Injection Channel O
Communication (7) Vref Bypass
Digital (7) Target Scan Rate (sps) |an00 |
¥ System Achieved Free-Run Scan Rate (sps) (=)
5D (CapSense, etc) 0 CYBSP_CSD CsD-30 Achieved Scan Durstion )
[] LCD Direct Drive 0 0 ~ Connections
[ Multi-Counter Watchdog Timer (MCWOT) 0 & Clock <unassigned> ~ v
[ Multi-Counter Watchdog Timer (MCWDT) 1 12-bit SAR ADC - Parameters  Code Preview
MNotice List g X
Qoo 1 oWamnings | [ 5Tesks @ 41nfos
Fix  Description Location
B8 The 'Clock’ parameter must not be empty. CYBC624AB7|-52D44: 12-bit SAR ADC [Clock]
=] The connection list fer signal "ChD Vplus” can't be empty CYBC624AB7|-52D44: 12-bit SAR ADC [Vplus Connection]
=] The connection list for signal "Ch1 Vplus” can't be empty CY8C624AB71-52D44: 12-bit SAR ADC [Vplus Connection]
[5]| & The AREF resource must be enabled for pass_0_sar_0 to work. CVACE24ABZI-52D44: 12-bit SAR ADC
D The SAR ADC reference voltage must be higher than 0.83 V CYBCE24ABZI-52D44: 12-bit SAR ADC
Ready

3. Notice also that a new task may appear in the Notice List pane.

See Icons for descriptions of the various icons displayed in the Device Configurator.

4. Double-click on a task to jump to the parameter that needs to be addressed.

Mame Yalue
v Peripheral Documentation
'/'_-"\, Configuration Help
¥ General
(7) Vref Select

QOpen 5AR Documentation

Internal Reference (from AREF Resource)

4 & Task: The Clock’ parameter |
) E0 must not be empty.

Clock that operates this block

(7) Vref Voltage (V) (= 0.000

'f?\, Number of Channels |2

'/'?\ Injecticn Channel [

/_\, Vref Bypass

'/\ Target Scan Rate (sps) |EDDDD
Achieved Free-Run Scan Rate (sps) [
Achieved Scan Duration [

v Connections
Clock <unassigned>

<unassigneds

12-bit SAR ADC - Parameters Code Preview

5. Select an appropriate parameter value and the task should be removed from the Notice List.
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6. When all tasks have been completed, select the Code Preview pane to see a preview of the code that will be
generated upon saving.

Code Preview g X

Enter search text...

/% NOTE: This is a preview only. It combines elements of the

* cycfg_peripherals.c and cycfg_peripherals.h files located in the folder

* C:fUsers/follettci/mtw2.4/5645/hw/Hello World/libs/TARGET CYSCKIT-062-WIFI-BT/COMPONENT_BSE_
*f

#include "cy_sar.h"

#include "cycig_routing.h”™

#include "cy_ sysclk.h”

#if defined (CY USING_HAL)
#include "cvhal hwmgr.h"

#endif //defined (CY_USING_HAL)

#$define pass_0_sar_0_HW 3&R

#define pass_0_sar_0_IRQ pass_interrupt_sar_ IRQn

#define pass_0_sar_0_CTIL ({uint32_t)CY_SAR VREF FWER_100 | (uint32_t)CY_SAR VREF_SEL BGR | (uint
#define pass_0_sar 0_SAMPLE ((uint32_t)S5LR SAMPLE CTRL EOS DSI_OUT_EN Msk | (uint32_t)CY_SAR RI
#define pass 0 sar 0 CHO CONFIG ((({uint32_t)SAR0 VPLUSO _PORT << SAR_CHAN CONFIG POS_FORT ADDR F
#define pass_0_sar 0_CHl1_CONFIG (({({uint32_t)SAR0_VPLUS1_PORT << SLR CHAN CONFIG FOS_FORT_ADLE F
#define pass_0_sar 0_VREF MV 1200UL

const cy_stc sar config t pass_0_sar 0_config =
v

£ >
12-bit SAR ADC - Parameters Code Preview

7. Usethe various tabs to enable and configure other resources as needed in the same manner as peripherals.
8. Save the *.modus file to generate source code.

The Device Configurator generates code into a "GeneratedSource" directory in your Eclipse IDE application,
or in the same location you saved the *.modus file for non-Eclipse IDE applications. That directory contains
the necessary source (.c) and header (.h) files that use the relevant driver APIs to configure the hardware.
Application code then uses this code to configure the system.

9. Usethe appropriate APl in your application code.

User Guide 8 of 27 002-24377 Rev. *I
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Code generation

4 Code generation

The Device Configurator generates structures, defines, and initialization code for the blocks on the chip. All
generated code is located in the GeneratedSource folder next to the *.modus file. Refer to the Peripheral Driver
Library (PDL) API Reference for more information about this code. Each enabled resource has a link to the
specific driver documentation in the Parameters pane.

Note: The Device Configurator generates code based on the hardware resources that are enabled. If a
resource is not enabled, no configuration will be generated for it. This means the resource will
retain its default reset state. In most cases, this is powered off. However, some features are
enabled by default, such as debug connectivity. To disconnect these features, you must call the
appropriate APl functions to turn the feature off.

The defines and structures are all named based on the resource that created it. In general, these have the form
<resource-name> config. These structures can be passed to the PDL functions that are responsible for
configuring the hardware block.

The functions are specific to a resource category and have names of the form init cycfg <resource-
category>. The init function for a particular resource type is located in GeneratedSource/cycfg_<resource-
category>.h. There are also the cycfg.h and cycfg.c files. Include the cycfg.h file in your application to access the
generated header files. The cycfg.c fileimplements init cycfg all (), which calls all other generated
functions, forexample init cycfg pins ().

The resource types include:
e Clocks: Peripheral clocks.
e Connectivity: Configuration of the programmable analog and digital routing resources.

e Peripherals: Fixed function analog and digital peripherals.

e System: Overall configuration function to setup all power and clock options.

Itis up to you to make use of the generated code based on the application's needs. This can be done as part of
the application’smain () loop.

User Guide 9 of 27 002-24377 Rev. *I
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5 GUI description

The Device Configurator GUI contains menus, icons, tabs, and several panes used to configure MCU peripherals.
5.1 Menus

5.1.1 File

o New - Creates a new *.modus file. See Create Design dialog for more information. The current file, if any,
will be closed.

e Open - Opens an existing *.modus file. The current file, if any, will be closed.
e Close - Closes the current file. If there are pending changes, you will be prompted to save the file.

e Save - Saves the current file and generates code for the related application. If there are errors in the
application, a dialog will indicate such. The file will still be saved.

e Save As - Saves the current file with a different name and/or location.

o Openin System Explorer - This opens your computer’s file explorer tool to the folder that contains the
*. modus file.

e Change Libraries - Opens a dialog to select a different device support library (props.json) file used for
resource Personalities.

The path to this file is usually stored relative to the *.modus file. If for any reason the device support library
cannot be found (for example, the *.modus file has been moved on disk), you will be prompted to manually
enter the path.

Note: This menu option is not available if a command-line override has been used.

¢ Recent Files - Shows up to five recent files that you can open directly.

e Update All Personalities - Use this item to update all resource Personalities. This opens a dialog showing
all the personalities in the design.

For example, if you load a *.modus file made with an older device support library, there might be many
warnings in the Notice List pane to update personalities or that a personality is no longer supported. Each
warning must be addressed, and doing so one at a time can be annoying. The Update All Personalities
menu item addresses them all at once.

e Exit - Closes the tool. You will be prompted to save any pending changes.

5.1.2 Edit

e Undo - Undoes the last action or sequence of actions.

e Redo - Redoes the last undone action or sequence of undone actions.

5.1.3 Settings

e Local Content: Check box to toggle between online and LCS mode, and read the local copy of the manifest
file installed from the LCS Manager. Refer to the LCS Manager CLI user guide for more details.

e Proxy Settings: Opens a dialog to specify direct or manual proxy settings.

5.1.4 View

Contains toggles to hide or show different panes. All panes are shown by default. There is also a command to
show or hide the Toolbar (hidden by default) and reset the view of the configurator to the default.

User Guide 10 of 27 002-24377 Rev. *I
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5.1.5 Help

e View Help - Opens this document.

e About - Opens the About box for version information, with links to open Infineon.com and the current
session log file.

5.2 Device tabs

The Device Configurator can be used to configure multiple devices. All devices selected in the Create Design
dialog display in top-level tabs above the Resource tabs.

I CYBCE24AB71-52044 CYW43012C0WKWBG I

Peripherals  Pins  Analeg-Routing  System  Peripheral-Clocks ~ DMA

All the settings for each Device tab are configured separately.

Note: If you need to update or change devices, you must use the command line option or make changes
manually by editing the makefile. You must also make changes to the BSP makefile or you will
encounter build errors. The best way to change devices is to create a custom BSP. Refer to the
ModusToolbox™ user guide for more details.

5.3 Resource tabs

See Resource tabs.

5.4 Panes
See Panes.
5.5 Icons

When configuring various options with this tool, you will see the following icons:

(@) Indicates there is a tooltip. Hover over the icon to display a brief message about the setting.

' Enables or disables a specific resource.

0 | D o There may be occasions where an error, warning, task, or info icon displays for an enabled resource.
o See Notice List pane for more details.

When shown in Parameters, this indicates that it is a read-only field.

= When shown for a Resource, this indicates the resource is locked and disabled. There is a tooltip
explaining why the resource is locked.

3 When shown for a Resource, this indicates the resource is locked and enabled. There is a tooltip
explaining why the resource is locked.

& After assigning a signal, clicking this icon jumps to the linked resource(s).
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6 Resources tabs

For most device families, the Device Configurator contains several tabs, each of which provides access to
specific resources. However, for some device families, there are no separate tabs; resources are shownina
single pane, sometimes under collapsible trees.

When you enable a resource, or select an enabled resource, the Parameters pane displays various configuration
options. As described under Icons, some enabled resources may contain errors, warnings, tasks, or infos that
indicate some action might be required to resolve the issue. See Notice List pane for more details.

Note: Only the tabs relevant for a selected device are displayed, so some of the tabs may not be included
for some devices.

e Peripherals - Options to enable any of the analog, digital, system, and communication hardware
capabilities of the chip that are not related to the platform.

e Pins - Options for all the pin related resources.

e Analog-Routing - This tab shows all the analog resources, whether enabled or not, and how they connect. It
also allows you to edit routes.

e System - Options for chip-wide configuration settings such as system clocks, power management, and
debug interfaces.

e Peripheral-Clocks - Options for all the peripheral clocks.

e DMA - Provides configuration of the DMA channel and transaction descriptors.

Each of the tabs (except the Analog-Routing tab) has the following features:

e Filter - The Resource column shows all available resources in an expandable tree. The filter box above the
list of peripherals allows you to limit the peripherals shown in the tree as well as a Hide disabled resources
filter button. There are also Expand and Collapse commands.

e Cut, Copy, Paste - Use these commands to move and copy settings from one resource of the same type to
another.

e When you use Cut, the settings will be copied to the clipboard, and the selected resource will be
disabled.

e When you use Copy, the settings will just be copied to the clipboard.

e When you use Paste, the selected resource will be enabled if needed. The selected resource must
support the same Personality name and version as the cut/copied resource.

e Name(s) - This displays the current resource name(s). This is an editable field where you can specify
optional, alternate names for this resource. This is also used in generated code.

Note: Enter any string in this field. The tool converts the name into a legal C identifier and replaces non-
legal characters with underscores. If entering more than one name, use a coma-separated list.

e Personality - Each resource has a "Personality" file that contains the information for the given resource.

e Some peripherals, such as Serial Communication Block (SCB) and Timer, Counter, Pulse Width
Modulator (TCPWM), have a pull-down menu to select a specific personality, such as UART, SPI, or I°C.

e Some peripherals have multiple personality versions from which you can select.

e Some peripherals have a read-only field that only shows the name of this resource’s personality file.
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6.1 Peripherals

The Peripherals tab/tree is where you enable various analog, digital, system, and communication peripherals
for the device to include in your application. The filter box and the hide disabled button above the list of
peripherals allows you to limit the resources shown in the tree. This tab allows you to enter one or more Names
for the resource. It also shows the selected Personality, where applicable.

6.1.1 Device families with tabs

Peripherals ~ Pins  Analog-Routing System Peripheral-Clocks ~ DMA
|E\1(E\f\\IE|IExI..‘ ,_,-_|\i = 4 B B

Resource MName(s) Personality
Analog
~ Communicaticn

Inter-IC Sound Bus (125) 0
[ Inter-IC Sound Bus (125 1
[ Quad Serial Memory Interface (QSPI) 0
“) SD Host Controller (SDHC) O
[] SD Host Centroller (SDHC) 1
Serial Communication Block (SCB) 0
[ serial Communication Block (SCB) 1
[ Serial Communication Block (SCB) 2
[] Serial Communicaticn Block (SCB) 3
Serial Communication Block (SCB) 4
[ Serial Communication Block (SCB) 5
[ Serial Communication Block (SCB) 6
[ Serial Communication Block (SCB) 7
[] Serial Communicaticn Block (SCE) 8
[] Serial Communication Block (SCB) 9
)
)
)

125-1.0

SPI-1.0 ~

UART-1.0 ~

[] Serial Communication Block (SCE) 10
[] Serial Communication Block (SCE) 11

[ Serial Communication Block (SCE) 12

) Universal Serial Bus (USE) 0 ush_0 USBFS Device-1.1 v
Digital

¥ System
CSD (CapSense, etc) 0 CYBSP_CSD Csp-20

[] LCD Direct Drive 0 Icd_D_drive
Multi-Counter Watchdog Timer (MCWDT) |

[ Multi-Counter Watchdog Timer (MCWDT) 1 [« dt_1

Real Time Clack (RTC) srss_0_rtc_D Real Time Clock-1.1

dt_0 Multi-counter watchdog-1.0

6.1.2 Device families without tabs

‘Ents\ﬁltsllsxl.” LL‘\f B Al KK HE
Resource Mame(s) Personality 8 7 6 5 4 3 2 1
v Peripherals
4 apc adc_0 ADC-1.0 TN TN TN TN TN
O arm 10 armio_ ccass) (e (P ) (P2 \ ( s \J (o7 | ( ) ) ez )| A
[ Audio audio 0 Y Y R
- B A A A A A A
Bluctooth bluctooth_0 Bluetooth-1.0 ) ) € € €@ | "m [ Y B
[ Clack clock 0 . A A A A A J
[ GCI-sec 0 ,—\\ (/,, \ p /1\\ —
7 vooc | (MRS | vssc | (P Peg | | vssc o ) ( P |
12c 12C-10 & <& \_,/J C
[ Keyboard Scanner keyscan 0 - an e
[ Low Moise/External Power Amplifiers [amplifiers 0 wrmn| | ur \ we )| P ) \ m ‘, voooz| | D
] PDM pdm_0 wr W
PWM O S— - =y
o P HTALO . R | 0icLoc Bt | vssC { mz } vonc E
[ pwmM 1 pwm_1 A 4
O pwm2 pwm_2 e~
1 PWM 3 pwm 3 HTALI k m2 } "\‘PZT /| F
O pwm 4 pwim_4 @
0 ewms pwm_5 : e (R | G
[] Quadrature Decoder quadrature 0
[ spi1 spi_0
spi2 il SPI-1.0 veovoD L H
[ swo swd_0
[ UART 1 (HCI UART) uart_0
UART2 (PUART) o G CYW20819A1KFBG (62-FBGA)
Pins ioss. 0 Pins-1.0 @ No Connect Assigned Power
@ = ® Enor Dedicated GPIO
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6.2 Pins

The Pins tab/tree is where you enable all the pin related resources. All available pins are shown in an
expandable tree, arranged by port number. The filter box and the hide disabled button above the list of pins
allows you to limit the pins shown in the tree. This tab allows you to enter one or more Names for the resource.
It also shows the selected Personality, where applicable.

The interactive pin package diagram shows the different states of the pins; there is a legend on the diagram.
You can enable/disable a pin by double-clicking it in the diagram. There are also zoom commands to resize the
diagram as needed. If you zoom the image larger than the frame area, scroll bars appear to move to different
area of the diagram. You can also press the [Alt] key to use the pan tool.

Pin states are shown in different colors:

e Black - No connect

e White - Disabled

e Green - Enabled

e Grey - Power/ground pins

e Orange - Fixed function pins
e Red - Error state

e Semi-transparent - The hardware resource’s enabled state has been locked.

6.2.1 Device families with tabs

CYBC624ABZI-S2D44  CYW43012COWKWEG
Peripherals  Pins  Analog-Routing  System  Peripheral-Clocks ~ DMA

‘Ente\ filter text... HZIFTEE & 20 KFRE
Resource MName(s) Personality 13 12 11 10 9 8 7 6 5 4 3 2 1
¥ Portd
PO[D] | CYBSP_LWCO_IN Pin-1.1 A
PO[1] Pin-1.1
[ PO[2] |ioss_0_p =
[ POI3] [ioss_0_pert_0_pin_3 c
PO[4] |CYBSP_SW2,CYBSP_USER_BTN1,CYBSP_USER_BTN | Pin- 1.1
[] PO[5] |CYBSP_LED_RGB_GREEN,CYBSP_USER_LED4 l D
~ Port1
P1[0]|CYBSP_CSD_RX,CYBSP_CS_RX,CYBSP_CS TH RX |Pin 1.1 | (o E
[ P1[1]|CY¥BSP_LED_RGB_RED, CYBSP_USER_LED3 .
vor | [ rem ) (B8 | F
[ P21 fioss_0_port_1_pin 2 y
[ P31 |ioss_0_pert_1_pin 2 v | (rin ) (e e G
[ P1[4]|CYBSP_SW4,CYBSP_USER_BTNZ
[J P1[5] {CYBSP_LEDS,CYBSP_USER_LED1,CYBSP_USER_LED e H
Port 2
Port 3 = VIHD! J
Port 4
Port 5 " K
Port & gy ey
Port 7 = @ @ L
Port 8
Port 9 C7) M
Port 10
Port 11 s | (e N
Port 12
Port 13 CYBCB24ABZ-52D44 (124-BGA)
Port 14 Assigned Power ® o
< > Dedicted GRIO.
H *
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6.2.2 Device families without tabs

[Enterfilter text. Z|¥ P Y
Resource Marne(s) Personality
> Peripherals
~ [ Pins ioss 0 Pins-10
[ DEV.WAKE [ioss_0_pin_40
[ HOST_WAKE |ioss_0_pin_41 A
A po CYBSP_D2,5W3,USER_BUTTON! Pin-10
= CYBSP_RST Pin-10 B
A p2 CYBSP_D4 Pin-10
A p3 CYBSP_D5 Pin-10
[ P4 CYBSP_D6 Pin-10 C
M ps CYBSP_D7 Pin-10
A 6 CYBSP_D11,5P12_MOSI Pin-10 D
A p2 CYESP_AD.CYBSP_THERM TEMP SENSE|Pin-10
= CY¥BSP_D13,5PI2_CLK Pin-10
M P10 CvBsP_AZ Pin-10 E
M p11 CYBSP_RSVD95PI2 C5 Pin-10
= F CYBSP_A4 Pin-10 B
M p13 CYBSP_AS Pin-10
A p1a CYBSP_DB Pin-10
M pis CYBSP D10 Pin-10 % G
M p17 CYBSP_D12,5P12_MISO. Pin-10 . B B 2 2 &
& p25 LED2 Pin-10 ) . (oo ) (5555 \smno\ (sane) (s H
M p27 LED1 Pin-10 o = = W W
M p22 12C_5CL Pin-10
&= o 2C.50A Pin10 CYW20819A1KFBG (62-FBGA)
[ P32 CYBSP_D1,UART_TX Pin-1.0 ~ @ No Connect () Assigned | Power
M pa7 CY¥BSP_DO,UART_RX Pin-10 ® Eor T —
€ >

6.3 Analog-Routing tab

The Analog-Routing tab shows the various analog resources in your application. Enabled resources are green.

Peripherals Pins  Analog-Routing System Peripheral-Clocks DA

ajejejala

LRCOMPT

fan Dan LanDan Do DanDan Dan B an Danlan T Lan s Lo Do B g Dan Da Do Dan Dan D an D
e i i oo o o { { i

200

There are zoom commands to resize the diagram as needed. The Edit & command opens the Analog Route
Editor.
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6.3.1 Analog Route Editor

The Analog Route Editor allows you to manually edit the routing of analog resources in your application. It also
provides the ability to lock-down all or some of the results.

Note: The Analog Editor can be some times be unresponsive during route recalculation. Please wait for it
to finish algorithm execution.

[ Analog Route Editor - Device Configurstor 3.10 o X

EEY

Enter filter text.. =

Nets (o)
ReservedByBSP
e ~ (5D (CapSense, etc.) 0 amuxbus_a, F
: BB (5D (CapSense, etc.) 0 amus
B P7[7] analog
O amuxtd_sa sl
O amuxtd_as_sr
O ioss_port7_p7_p47
~ (5D (CapSense, etc.) 0 amuxbus_b, |
B 5D (CapSense, etc.) 0 amuz
B P7[7] analog
O amuxtd_bb sl
O amuxtd_bb_sr
O ioss_port7_p7_p57
~ (5D (CapSense, etc.) 0 amuxbus_a,
B 5D (CapSense, etc.) 0 amuz
- Pg[6] analog
O amuxtd_sa sl
O amuxtd_as_sr
O ioss_portd_p8_p46
~ CSD (CapSense, etc) 0 amuxbus_b, |
B 5D (CapSense, etc.) 0 amuz w
< >

)

Switch Legend

Open

T O Open (edit mode)

od ] Q) Closed and unlocked
© Closed and unlocked (selected)
@ Closed and locked
. Closed and locked (selected)

Closed and locked (by a different net)

Note: If there are configuration errors, complete routing results will not be available; only locked
resources. If you open the Analog Editor in this error state, a warning message will display. You can
still lock and unlock switches, but you won’t get complete routing results as long as the
configuration has errors.

6.3.1.1 Select aresource

To select an analog resource, click on it. Any enabled (green) element in the tree can be selected. The resource
and the associated route(s) become blue. Also, the Edit Route command appears on the toolbar. See Edit
Route.

- amuxt4_aa_sr|

r
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At the same time, the selected analog resource(s) is highlighted in the Nets tree.

Enter filter text... & | =

" MNets Locked | *

0 amuidd_bb_sl
0 amuxtd_bb_sr
0 ioss_portd_p8_p536
* (5D (CapSense, etc.) 0 amuxbus_b, PB[7] analog
- 5D (CapSense, etc.) 0 amuxbus_b
=~ PA[7] analog
0 amuxtd_bb_s|
o O amuxtd_bhb_sr
& — O ioss_portd_p8_p57
~ P10[0] analog, 12-bit SAR ADC vplus
== P10[0] analog
- 12-bit SAR ADC vplus
0 passl_sarmux)_swl
= P10[1] analeg, 12-bit SAR ADC vplus
= P10[1] analog
- 12-bit SAR ADC vplus
0 passl_sarmuxd_swl

4 2

Switch Legend
Open
™ A foctit e

You can also select items in the tree to highlight them in the diagram.

Enter filter text... & | I

Mets Locked [*
{:} amuxtd_bb_sl
{:} amuxtd_bb_sr
{:} ioss0_portd_p8_p36
* (5D (CapSense, etc.) 0 amuxbus_b, PA[7] analog
= 5D (CapSense, etc) 0 amuxbus_b
== P3[7] analog
{:} amuxtd_bb_sl
{:} amuxtd_bb_sr
{:} ioss0_portd pd p37

= P10[0] analog, 12-bit SAR ADC vplus
B 12-bit SAR ADC vplus
{:} pass(_sarmuxl_sw0

= P10[1] analog, 12-bit SAR ADC vplus
- P10[1] analog
B 12-bit SAR ADC vplus
{:} pass_sarmuxl_sw1

~—<{
< i

SARADCD =
LS F »
wplis
Switch Legend
Open

6.3.1.2 Edit Route

With an editable analog resource selected, click the Edit Route command to enable edit mode. If multiple
routes are selected, a pull-down menu displays to select the route to edit. You cannot edit multiple routes at
the same time.

In edit mode, the net tree shows only the applicable route entries, and you cannot select resources using the
tree. However, the lock/unlock check boxes remain enabled for use. The inactive switches change color to
indicate they can be selected to use for the route being edited.

Route changes are live with updates applied automatically as you make changes. Selecting a switch adds it to
the current route in a locked state and the route tree is updated to reflect the modifications.
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If a change results in an error, a message displays. The routes are automatically rolled back to the previous
state, so you will lose at most the last invalid change.

The toolbar shows the Finish edit command to return the editor to selection mode.

Note: If a route is edited so that it uses switches associated with a location where no personalities are
instantiated, you must manually power on the containing block at startup in order for the switches
to function. Refer to the PDL API Reference Guide and the Device Technical Reference Manual for
more details.

6.4 System tab

The System tab provides access to system-level items, such as system clocks, power management, and debug
interfaces. All available resources are shown in an expandable tree. The filter box and the hide disabled button
above the list of resources allows you to limit the items shown in the tree. This tab allows you to enter one or
more Names for the resource. It also shows the selected Personality, where applicable.

Peripherals  Pins  Analog-Routing  System  Peripheral-Clocks ~ DMA

[Enter filter tex...

Resource
Debug
[] EM_EEPROM
Power

~ (@) System Clocks
~ FLL+PLL

Namefs)

Personality

Debug Access-1.0

Pouwer Settings-1.3
SysClocks-12

FLL

(@ PATH_MUXO
(@ PATH_MUX1
(@ PATH_MUK2

: AL §
FLL-2.0 IMO 100 MKz + 24% CLK PATHO

PATH_MUX-1.0

PATH_MUX-1.0 ko

PATH_MUX-1.0 | | ﬁ .
JE— '[ T QK PAH A\

K T CLK_PERI
0w s 24n
CLK_TIMER
4 | s ALK ALT
1 SYSTICK

[s27ee w2 cors

PATH_MUX-1.0 BTaK
PATH_MUX-1.0
PATH_MUX-1.0
PLL-20

() PATH_MUX3
(&) PATH_MUX4
(@) PATH_MUX3
PLLO
O e
~ High Frequency
CLK_FAST
CLK_HFO
[ CLK_HF1
[ CLK_HF2
[ CLK_HF3
[ CLK_HF4
[ CLK_HFS
CLK_PERI
CLK_SLOW
~ Input
O eco
[ EXTCLK

BLLT
CLKPATHZ 1y

CLK PATHZ

CLK_FAST-1.0
CLK_HF-1.1

QLK PATHA Ay

aK_PUMP

CLK PATHS

[ aklF
27684 + 00 1%,

CLK_PERI-1.0
CLK_SLOW-1.0

The interactive clock diagram shows all the system clocks and how they connect to each other. You can
enable/disable a clock by double-clicking it in the diagram. Enabled clocks are green, disabled clocks are white,
and clocks in error state are red. There are also zoom commands to resize the diagram as needed.

Note: The semi-transparent (faded) elements in the diagram indicate that their enabled state is locked.

002-24377 Rev. *I
2023-05-08

User Guide 18 of 27



o _.
ModusToolbox™ Device Configurator user guide |n f| neon

Resources tabs

6.5 Peripheral-Clocks tab

The Peripheral-Clocks tab lists all the clocks in a design used to drive the various peripherals. All available
clocks are shown in an expandable tree. The filter box and the hide disabled button above the list of resources
allows you to limit the items shown in the tree. This tab allows you to enter one or more Names for the
resource. It also shows the selected Personality, where applicable.

Peripherals Pins  Analog-Routing System Peripheral-Clocks DMA

[Enterfilter . Z|7 B 4=l
Resource Name(s) Personslity
v Bbit

8 bit Divider 0 |CYBSP_CSD_CLK_DIV,CYBSP_CS_CLK_DIV| Peripheral Clock-1.0
8 bit Divider 1 peri_0_div_8_1 Peripheral Clock-1.0
[ 8 bit Divider2 | peri 0 2
[ 8 bit Divider 3 |pe
[ 8 bit Divider4 | pe
[ 8 bit Divider5 | pe
[ & bit Divider & | peri_ 0 6
[ & bit Divider 7 peri_0_div 8.7

16 bit

¥ 16.3 bit

[ 16.5 bit Divider 0
[ 16.5 bit Divider 1 |p
[ 16.5 bit Divider 2 |
[ 16.5 bit Divider 3 | peri_0_d

24.5 bit

6.6 DMA tab

The DMA tab lists all the DMA resources in the design. All available DMA channels are shown in an expandable
tree. The filter box and the hide disabled button above the list of resources allows you to limit the items shown
in the tree. This tab allows you to enter one or more Names for the resource. It also shows the selected
Personality, where applicable.

Peripherals ~ Pins  Analog-Routing ~ System  Peripheral-Clocks ~ DMA

[Enter filter text.. £|F B 4B
Resource Namefs) Personality ~
~ DMA Controller
DMA Channel 0
[] DMA Channel 1
[ DMA Channel 2
[] DMA Channel 3
~ DMA DataWire 0
[ omA DataWire 0: Channel 0 |c
[] DMA DataWire 0: Channel 1 |c
[] DMA DataWire 0: Channel 2 |c
[] DMA DataWire 0: Channel 3 |c
[] DMA DataWire 0: Channel 4 |c
[ DMA DataWire 0: Channel 5 |c
[] DMA DataWire 0: Channel 6 |c
[] DMA DataWire 0: Channel 7 |c
[] DMA DataWire 0: Channel 8 |c
[ oma DataWire 0: Channel 8 |c
[] DMA DataWire 0: Channel 10 |c
[] DMA DataWire 0: Channel 11 |c
[] DMA DataWire 0: Channel 12 |c
[] DMA DataWire 0: Channel 12 ¢
[ DMA DataWire 0: Channel 14|c
[ DMA DataWire 0: Channel 15 |c
[] DMA DataWire 0: Channel 16 |c
[] DMA DataWire 0: Channel 17 |c
[ DMA DataWire 0: Channel 18|c

0] DMAC-1.0
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7 Panes

The Device Configurator tool contains the following primary panes that display information based on what is
selected in a particular resource tab:

e Parameters - This pane shows the various parameters for any specific resource enabled in one of the tabs.

e Notice List - This pane shows any errors, warnings, tasks, and infos for the application.

e Code Preview - This pane shows a preview of the code that will be generated for the selected resource
when you save the *.modus file.

7.1 Parameters pane

The Parameters pane contains all the parameters for a selected, enabled resource. This pane will show
different parameters for each resource, grouped by various categories. For example, the parameters for the
TCPWM peripheral are completely different than those for a pin resource. The filter box above the list of
parameters allows you to limit the items shown in the pane. Some resources also provide a link to launch a
separate configurator.

TCPWM[0] 32-bit Counter 0 - Parameters X
|E-*'.e-"".e-".e-'. Z10 B F
Mame Value

~ Peripheral Documentation

7 Configuration Help  Open Timer - Counter (TCPWM) Documentation

~ General

'Z?'Z' Clock Prescaler Divide by 1 ~

(2) Counter Resolution ) 32-bits

7 Run Mode Continuous

7 Count Direction Up

(%) Period 32788

7 Compare or Capture | Capture ~
v Capture

() Capture Input Disabled ~
~ Interrupts

7 Interrupt Source MNone ~
v Inputs

:J Clock Signal <unassigned> ~

() Count Input Disabled v

(7) stop Input Disabled v

2} Reload Input Disabled ~

7 Start Input Disabled ¥
v Qutputs

(2) Overflow <unassigned>

7 Underflow <unassigned>

'-" Capture (cc_match) | <unassigned>
v Advanced
(2) Store Config in Flash

7.1.1 Configuration help

Nearly all resources provide a link to open the Peripheral Driver Library (PDL) documentation to the specific
driver. This is the Doxygen-generated HTML file located in the installation directory. To see links to the
documentation, simply highlight a resource; you do not need to enable it.

7.1.2 Parameter descriptions

As described under Icons, all parameters have a tooltip icon " to indicate there is information about the
parameter. Hover the mouse cursor over the icon to display a description of the parameter.

User Guide 20 of 27 002-24377 Rev. *I
2023-05-08



o _.
ModusToolbox™ Device Configurator user guide |n f| neon

Panes

7.1.3 Parameter values
Different parameter types have different ways to specify a value, as follows:

e Pull-down Menu - For parameters with a specific set of values, use the pull-down menu to select the
appropriate value.

o Selection Box - For parameters with a variable set of values, click the ellipsis [...] button to open a
selection box. There, use the check boxes to select one or more appropriate values for the parameter.

Note: After selecting these parameter types, use the Go To & button to jump to the selected resource.

e Check Box - For parameters with a true or false value, use the check box to enable or disable the
parameter.

o Text Box - For parameters with editable values, type the value in the text box.

Note: Values preceded by '0' are interpreted as octal; values preceded by ‘0x’, ‘0X’, and ‘# are
interpreted as hexadecimal.
7.1.4 Signal Select Indicators

For parameters where you select a signal, there is a pull-down menu for single-select signals and a button to
open a dialog for multi-select signals.

v CapSense Sensors
(7) Button0_Rx0 & | (@ Pa[1] analog (CYBSP_CSD_ETMO, CYBSP_CS_BTND) [SHARED] v
(7) Button0_Tx & | (O P1[0] analog (CYBSP_CSD_TX, CYBSP_CS_TX) [SHARED]
(7) Button] Rx0 & | © P10[3] analog (CYBSP_AS, CYBSP_2_11) ~
— - @ P10[6] analog (CYBSP_AG, CYBSP_J2_13)
(2) Button1_T & | @ pi07] analog
(@) LinearSliderd Snsh £ | O PoIo] analog (CYBSP_WCO_IN) [USED]
o T O PO[1] analeg (CYBSP_WCO_OUT) [USED]
(2) LinearSlider0_Sns1 & O po[2] analog (CYBSP_D7)
() LinearSlider0 Sns2 £ | O POI3] analog (CYBSP_LED_RGB_RED, CVBSP_USER_LED3)
= (O PO[4] analeg (CYBSP_SW2, CYBSP_USER_ETM1, CYESP_USER_ETM)
() LinearSlider0_5ns3 &
() LinearSlider0_Sns4 I8 @ P1[0] analo SD_TX, CYE DX [SHARED] oo

The signals have guidance icons next to them to indicate the status of the signal, as follows:

e Green - preferred
e Yellow -valid
e Red - constrained

After selecting one or more signals, use the Go To & button to jump to the selected signal or open a dialog to
select from multiple signals.
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7.1.5 Launch other configurators

For peripherals with their own configuration tools (CapSense, SegLCD, etc.), the Device Configurator provides
links to launch those separate configurators. After enabling the peripheral on the Peripherals Tab, the
Parameters pane contains a <Configurator> parameter, where <Configurator> is the name of the other
configurator.

v External Tools

( ‘? CAPSEMSE™ Configurater | Launch CAPSENSE™ Configurator

{ 7 CAPSEMSE™ Tuner Launch CAPSENSE™ Tuner

Click on [Launch < Configurator > ...] to launch the configurator.

Note: When launching another configurator from the Device Configurator, it passes information, such as
the location of the *.modus file and any configuration data, to that other configurator. Those other
configurators can be launched independently from the Device Configurator. When launched
independently, you will need to either open or create the appropriate configuration file for that
tool. If you want to use the configuration tools independently for the same application, make sure
to save the source files in the correct "GeneratedSource" folder for the appropriate application.

7.2 Notice List

The Notice List pane combines notices (errors, warnings, tasks, and infos) from many places in your design into
a centralized list. If a notice shows a location, you can double-click the entry to navigate to the error or warning.

Matice List g x
021 Errors 1 0 Wwarnings U 1Task 00 Infos

T Fix Description Location 2
E The 'Clock Signal' parameter must not be empty. CYBC6247BZ1-D54: TCPWMID] 32-bit Counter & [Clock Signal]
(%) ‘}\4 ¥ | The personality 'lp_assist_wifi-1.0', instantiated at 'wifi[0].power[0], is not available in any selected library. CYWA343WKUBG: Wi-Fi

O q\, ~ | The personality 'lp_assist_bt-1.0', instantiated at 'bt[0].power[0], is not available in any selected library. CYW4343WKUBG: BT

(] The Low Frequency Clock Source (typically ILO) should be enabled CY¥8C6247BZ1-D34: LCD Direct Drive 0

A v The 1K HED clnck is nnt enahled CYACRZATRTI-NS4: TSN (CanSense etc) ) 5
Ready

Notices display in rows. Use the filters above the notices to show or hide different types of notices, as follows:
o Errors - These indicate there is at least one problem that must be addressed before you can build your
application. Typical errors could include compiler build errors and connectivity errors.

e Warnings - These report unusual conditions that might indicate a problem, although you can usually build
the application regardless.

e Tasks - These are actions you need to perform to resolve an issue, such as enabling a resource. If you save
without resolving a task, it becomes an error.

¢ Infos - These are informational messages from the system to indicate something occurred.

The Notice List pane contains the following columns (each column header contains an arrow control to change
the sorting of the notices in the table):

e Icon - Displays the icons for the error, warning, task, or info.

e Fix - This may display a wrench icon, which can be used to automatically address the required notice.

o Description - Displays a brief description of the notice.

o Location - Displays the specific line number or other location of the message, when applicable.
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7.2.1 Fix a task/error

When a wrench * icon displays in the Fix column, click on it and select the appropriate action from the pull-
down menu. When all related issues have been addressed, the notice will be removed from the Notice List
pane.

a\‘ Block TCPWH[1] 16-bit Counter 22* rmust be enabled for *teparm
patt of a net,

Enable Tirmer - Counter' at TCPWR[L] 16-bit Counter 22°
Enable 'Puhd’ at TCPWRA[L] 16-bit Counter 22'
Enable '"Quadrature Decoder’ at "TCPWR[1] 16-bit Counter 22

Note: The fixes listed are not necessarily the only way to fix the issue. They are merely common options.
Also, if you save the *.modus file with outstanding tasks, they become errors saved in the
GeneratedSource/cycfg_notices.h file.

7.2.2 Copy a notice

You can copy a notice to your system’s clipboard using [Ctrl]+[c] or right-click and select Copy. Then, paste the
notice text into an email, document, and so on.

7.3 Code Preview pane

The Code Preview pane is a read-only preview of the code that will be generated for the currently selected
resource when you save the *.modus file. As you update configuration options, the Code Preview pane updates
the code shown. This code will be written to the appropriate file(s) located in the GeneratedSource folder of
your application.

Code Preview (=]E)
hal

/* HOTE: This is a preview only. It combines elements of the

* cycfg peripherals.c and cycfg_peripherals.h files located in the folder

% C:/Users/cycfg_per/mtwl.3/3728/hw/mth_shared/TARGET_CYSCKIT-062-WIFI-BI/latest-va.
b

#include "cy_smif.h"
#include "cycig_gspi_memslot.h"
#if defined (CY_USING HAL)
#include "cyhal_ hwmgr.h"
#endif f/defined (CY_USING_HAL)
. . - Copy
#$define smif 0 _HW SMIFO
#define smif 0_IRQ smif_ interrupt_ IRQn Select All
$define smif O_MEMORY_MODE_ALIGMENT_ERROR (0T :
#define smif 0 RX DATA FIFO UNDERFLOW (OUL) Find Ctrl+F
#define smif 0_TX COMMAND_FIFO_OVERFLOW (OUL)| ' Find next Fa
$define smif_O_T¥_DATA FIFO OVERFLOW (OUL)
$define smif 0 R¥ FIFO TRIGEER LEVEL (OUL) Find previous Shift+F3
$define smif 0_TX_FIFO_TRIGEER_LEVEL (OUL)
#define smif O0_DATALINESO_1 (0UL)
#define smif_ 0_DATALINESZ 3 (0OUL)
#define smif 0_DATALINES4 5 (OUL)
#define smif 0_DATALINESE 7 (0OUL)
#define smif 0_550 (0UL)
#define smif_0_3551 (0UL)
#define smif 0 532 (0ULY b
L]

Quad Serial Memory Interface (Q5P[) 0 - Parameters Code Preview

You can select and copy code from this pane using [Ctrl]+[C] key or using the right-click menu option.

You can use the Search feature to find instances of specific terms.
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8 Version changes

This section lists and describes the changes for each version of this tool.

Version | Change Descriptions Notes
1.0 New tool.
1.1 Added support for WICED Bluetooth devices.
This affects the file name generated during code
generation. Older versions of the Device
Configurator generated cycfg_platform.(c/h) files;
Chonged e Pltiorm a0 Sysom Lottt e ) s o
manually remove the old cycfg_platform.(c/h) files
2.0 and update any references you created to use the
new file names.
Moved the Analog-Routing Editor to a tab.
Updated the File menu for library settings.
Added Update All Personalities menu item.
Added the ability to enter multiple resource Names using comma-separated list.
Added Open System Explorer menu item.
1 Added Change Devices menu item and dialog.
Added Undo/Redo operations to the Edit menu.
Added major/minor version number to the title bar.
Added Copy feature to the Notice List.
520 Added ability to see documentation links without enabling a resource.
Added frequencies to clock diagram.
Added feature to support incremental patch updates.
Added Search feature to Code Preview.
Implemented various performance improvements.
2.21 Fixed an issue with multiple font sizes in the GUI.
Fixed the PDL display name when using the MTB flow.
Updated to allow analog routing from the SAR to any analog resource or pin.
Removed Change Devices dialog. Use command line tools instead.
3.0 Updated the tool to recognize obsolete devices. Displays an error in the Notice List instead of
blocking the file from being opened.
Added path to files in the Code Preview Pane.
Fixed the name conflict warning notices when the selected device is changed to not check against non-
existent chip locations.
Added a ‘Fix’ to name conflict warnings in the notice list.
Locked down number entry to the English format (decimal place is always a period).
Made various performance improvements.
310 Added a search filter to the dialog that allows for the selection of multiple signals.
Added additional MPN consistency checking preprocessor macros to cyf_notices.h.
Added a log file that can be accessed from the About box. Debug messages are redirected to it.
Added back the ‘Fix’ to the MPN consistency notice.
Fixed error message displayed when the same *.modus file is opened in multiple instances of the Device-
Configurator and mpn checking command line arguments are provided.
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infineon

Version | Change Descriptions ‘ Notes
Updated back-end to support multi-core applications.
4.0 Updated Create Design dialog.
Changed device library file from xml to props.json.
4.10 Added Settings menu and items.
Improved parameter view sizing.
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Revision history

Revision | Date Description

*x 2018-11-21 New document.

*A 2019-03-01 Updated to version 1.1.
*B 2019-10-17 Updated to version 2.0.
*C 2020-03-27 Updated to version 2.1.
*D 2020-09-01 Updated to version 2.20.
*E 2020-12-10 Updated to version 2.21.
*F 2021-03-15 Updated to version 3.0.
*G 2021-09-24 Updated to version 3.10.
*H 2022-09-12 Updated to version 4.0.
*| 2023-05-08 Updated to version 4.10.
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